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6 Lomakkeet ja raportit 
Accessin lomake (form) on taulukkonäyttöä miellyttävämpi 
ja monipuolisempi tapa käsitellä tietoja. Se voidaan tehdä 
joko todella helposti nk. lomakevelhon (FormWizard) 
avulla tai "käsin" poimimalla halutut asiat (mm. kenttä-
määrittelyt) yksitellen lomakkeeseen. Lomakevelho kyselee 
tarvittavat tiedot ja muodostaa lomakkeen heti käyttö-
valmiiksi. Sen vuoksi on järkevintä luoda lomake ensin 
ohjatusti lomakevelholla ja muokata sitä sen jälkeen 
halutun kaltaiseksi. Syntyneellä lomakkeella voidaan 
saman tien katsoa, muuttaa, lisätä ja poistaa taulun 
tietoja — ei tarvita ohjelmointia! 

6.1 Lomakkeen tekeminen 

Lomake voidaan tehdä monella eri tavalla. Nopein tapa on 
käyttää automaattista lomakkeen luomista eli AutoForm-
toimintoa.  

Automaattinen lomakkeen luominen eli Auto-
Form 

Autoform (Automaattinen lomakkeen luominen) muodostaa 
valitusta taulusta/kyselystä yksisarakkeisen perus-
lomakkeen, jossa on mukana kaikki taulun/kyselyn 
kentät. Voit valita kentät allekkain (Columnar), kentät 
vierekkäin (Tabular) tai taulukkonäytön (Datasheet) 
luovan vaihtoehdon. 

Tehdään ensimmäisenä harjoituksena lomakevelholla 
Tuote-lomake, jolla tiedot voidaan syöttää TUOTE-
tauluun. Avaa ensin LASKU1-tietokanta, jossa TUOTE-
taulu sijaitsee. Toimi tämän jälkeen seuraavasti: 

1. Aloita uuden lomakkeen tekeminen valitsemalla ensin 
se taulu (tai kysely), josta haluat lomakkeen tehdä. 
Voit halutessasi valita sen myöhemminkin. 

� Napsauta TUOTE-taulua. 
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2. Valitse työkalulistasta -työkalu ja valitse 
avautuvasta listasta Form (Lomake). 

���� Listassa on ensimmäisenä AutoForm, joka on 
kaikkein nopein tapa tehdä lomake. Olemme 
kuitenkin huomanneet, että se ei ole aina yhtä fiksu 
kuin seuraavassa kohdassa näkyvät AutoForm-
vaihtoehdot. 

3. Valitse kentät alekkain laittava (ja tietueen kerrallaan 
näyttävä) Columnar-lomakevelho.  

  
4. Paina Enteriä eli OK:ta. Access tekee valmiin 

lomakkeen jota ei vielä ole talletettu tietokantaan. 

 

Lomakkeen perusta on nyt valmis. Tämän jälkeen 
esimerkiksi Yes/No-kenttä voidaan muuttaa 
valintaruuduksi (Check Box) ja käyttää mm. lomakkeen 
ulkoasuun automaattista muotoilua (AutoFormat). 
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Lomakkeen tallennus 

� Tallenna lomake komennolla File → Save (Tiedosto → 
Tallenna) tai näppäinkomennolla Ctrl + S. 

� Anna lomakkeelle nimeksi joko TUOTE tai Tuotetiedot 
ja paina OK. 

 

���� Access ehdottaa lomakkeen nimeksi taulun nimeä 
(TUOTE). Kirjoita sen päälle halutessasi uusi nimi. 
Ole kuitenkin johdonmukainen lomakkeiden nimeä-
misessä (esimerkiksi kirjainkoko: käytätkö ISOJA vai 
pieniä kirjaimia). 

Lomaketyypit 

Seuraavassa taulukossa esitellään eri lomaketyyppi-
vaihtoehtojen ominaisuuksia: 

 
Columnar (yksisarakkeinen): jokainen tietueen 
tieto eli kenttä on omalla rivillään yhdessä 
sarakkeessa; kenttien nimet ovat aina kentän 
vasemmalla puolella. Tietueet tulevat näytölle 
peräkkäin. Yleisimmin käytetty lomaketyyppi. 

 
Tabular (taulukkomuotoinen): yksi tietue on aina 
yhdellä rivillä, jolloin lomakkeelle mahtuu 
kerralla näkyviin useita tietueita; kenttien nimet 
ovat otsikoina ensimmäisellä rivillä. 

 

Datasheet on myös taulukkomuotoinen, mutta 
hieman tiiviimpi (aivan kuten avattu taulu tai 
kysely). 

 

PivotTable Wizard luo Excelin Pivot-taulukkoa 
käyttäen ristiintaulukoinnin samanlaisista 
tiedoista (esim. samaan tuoteryhmään 
kuuluvista tiedoista). 
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Accessin versiossa 2 oli valittavissa suoraan 
Main/subform (pää- ja alilomake) -tyyppinen lomake. 
Versiosta 7.0 lähtien lomakkeeseen on voitu valita useita 
tauluja tai kyselyjä, joista tiedot haetaan lomakkeelle. 
Ensimmäiseksi valitusta taulusta tai kyselystä tulevat 
tiedot lomakkeen yläosaan (päälomakeosa) ja muut ovat 
alilomakkeina lomakkeen alaosassa (alilomakeosa).  

Lomakkeen ulkoasutyyli 

Kun olet päättänyt lomaketyypin, pitää sinun vielä valita 
lomakkeen ulkoasun tyyli. Päätös on sikäli tärkeä, että 
samaa tyyliä on syytä käyttää kaikissa lomakkeissa 
yhdenmukaisuuden säilyttämiseksi.  

Seuraavassa kuvassa näkyy kaksi Accessin tarjoamista 
valmistyyleistä (Autoformat). Kaikkiaan on 10 tyyliä mistä 
valita. 

   
Clouds (Pilvet) International  

(Kansainvälinen) 

Valmistyylin valinta on selostettu luvussa Automaattinen 
muotoilu, sivu 118. Kehoitamme pohjan ulkoasutyylin 
valinnassa malttiin: tärkeintähän on tietokannassa oleva 
tieto, ei lomakkeen värikäs ulkoasu! 

6.2 Lomakkeen muokkaus 

Seuraavaksi muokataan tehtyä TUOTE-lomaketta. Ensim-
mäisenä Arvonlisäverollinen-kenttä muutetaan teksti-
kenttää havainnollisemmaksi valintaruuduksi (Check 
Box). Yleensä aina lomaketta joudutaan muokkaamaan 
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jälkeenpäin — huippuälykästä velhoa joudutaan 
odottamaan vielä muutama vuosi. 

� Avaa lomake suunnittelutilaan (Design View) 
napsauttamalla -työkalua. 

Lomaketta on erittäin helppo muuttaa ja testata ilman 
ohjelman kääntämistä 3 siirtymällä vuorotellen lomake-
näyttöön  -painikkeella ja takaisin suunnittelutilaan 
painamalla  -painiketta. Suunnittelutilassa voit tehdä 
mm. seuraavia muotoiluja: 

• muuttaa kohteiden kokoa ja järjestystä 

• lisätä tekstiä ja muuttaa tekstin ulkoasua (esim. 
fonttia) 

• lisätä uusia tai poistaa olemassaolevia kenttiä (field 
tai control) 

• muuttaa nk. sarkainjärjestystä (tab order), jolla 
siirrytään kentästä toiseen 

• muuttaa kenttien, lohkojen (section) tai koko 
lomakkeen ominaisuusmäärittelyjä 

• muuttaa lomakkeen kokoa 

 
Kuva 10. Kaikki lomakkeessa näkyvät kentät ovat 
muokattavia kohteita. 

Koska jokaiselle kohteelle voidaan antaa erillinen nimi ja 
joillekin voidaan antaa myös kontrollin lähde (control 
source), kutsutaan kohteita myös kontrolleiksi. Suomen-
kielisessa Accessissa puhutaan ikkunaobjekteista. 

                                  
3 Perinteisillä ohjelmointikielillä (C, Pascal jne.) tehdyt ohjelmat 

pitää usein kääntää ja linkata, että niistä saataisiin toimiva 

sovellus. Access osaa tulkita tehdyt muutokset välittömästi. 
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� Suurenna lomakeikkunaa hieman ja valitse näytölle 
työkalut joko -työkalulla tai komennolla View → 
Toolbox (Näytä → Työkaluryhmä). 

� Poista lomakkeella oleva Arvonlisäverollinen-kontrolli 
valitsemalla se hiirellä ja painamalla Delete-näp-
päintä. 

���� Vaikka Accessissa voidaan vaihtaa useimpien 
kontrollikenttien tyyppi Format-valikon Change To 
(Muotoile → Muuta) -komennolla, ei Yes/No-kenttää 
voida vaihtaa valintaruuduksi (Check box). 

� Napsauta Check Box (Valintaruutu) -työkalua, vie sen 
jälkeen hiiren osoitin kenttäluettelossa olevan 
Arvonlisäverollinen-rivin päälle ja vedä se kenttä-
luettelosta hiirellä siihen kohtaan lomakkeessa, johon 
haluat kontrollin asemoida.  

 

���� Tämä vedä ja pudota-toiminto luo sidoksen 
tietokannan TUOTE-taulussa olevan Arvonlisä-
verollinen-kentän ja lomakkeella olevan kohteen 
välille.  

Vielä täytyy asemoida selite (label) valitsemalla se hiirellä 
ja sijoittaa se oikeaan paikkaan lomakkeella.  

� Vie hiiren osoitin Arvonlisäverollinen-tekstin vasem-
paan ylänurkkaan tumman pisteen päälle, jolloin 
osoitin muuttuu kädeksi, jossa yksi sormi osoittaa 
ylöspäin . Paina hiiren vasen nappi pohjaan ja vedä 
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seliteteksti vasemmalle samaan linjaan muiden 
selitetekstien kanssa.  

�  

 →   

���� Access loi alunperin aivan oikeaoppisesti selitetekstin 
valintaruudun oikealle puolelle. Tässä näytössä 
kenttä on kuitenkin siistimmän näköinen, kun 
seliteteksti on vasemmalla. 

Kohteiden valinta 

Sinun täytyy ensin osata valita kohde, jotta voisit muuttaa 
sitä. Valinta tehdään napsauttamalla haluttua kohdetta 
(kontrollia) yhden kerran nuoliosoittimella , jolloin 
kohteen ympärille ilmestyy mustat pisteet (kahvat, 
handles). Esimerkiksi edellisessä kuvassa on napsautettu 
Arvonlisäverollinen-kenttää ja seuraavassa kuvassa on 
valittu Tuotekoodi-kenttä. 

 
���� Valitessasi kohteen johon liittyy selittävä tekstikenttä, 

tulee molempien kohteiden vasempaan ylänurkkaan 
muita neliöpisteitä hieman suurempi tumma neliö. 
Näet kuitenkin muista pienistä neliöistä, oletko 
valinnut selittävän tekstin (kentän otsikon) vai 
varsinaisen kentän.  

Voit valita useamman kohteen kerralla joko "lassoamalla" 
alue kohteiden ympärille 4 (hiirellä vetämällä) tai pitämällä 
Shift (eli vaihto) -näppäintä alhaalla ja napsauttamalla 
valintaan tulevia kohteita. 

 

                                  
4 Tarkemmin sanottuna kohteet voidaan valita vetämällä hiirellä 

"lasso" kohteiden päälle. 
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� Voit valita kaikki samalla rivillä sijaitsevat kohteet 
napsauttamalla hiirellä  -osoittimella asteikko-
viivaimen vasemmassa laidassa näkyvien numeroiden 
päällä. Vetämällä alaspäin voit valita useita rivejä 

 
Accessin “kolmen klikkauksen” idea: 

1. Ensimmäinen klikkaus tuo kahvat kohteen ympärille, 
jolloin voit siirtää, venyttää tai muuten muotoilla 
kohdetta. 

2. Toinen klikkaus vie hiiriosoittimen kohteen sisään, 
jolloin voit kirjoittaa kohteen sisään tekstiä. Kaksois-
napsautus valitsee sanan kohteen sisältä. 

3. Jos hiiriosoitin meni vahingossa kohteen sisään 
(kohdan 2 mukaan), etkä kuitenkaan halua kirjoittaa, 
vaan siirtää tai muotoilla, klikkaa ensin jonnekin 
sivuun ja palaa kohtaan 1.  

Ominaisuusmäärittelyt 

Jokaisella kontrollikentällä (ikkunaobjektilla), lohkolla 
(Form Header, Detail ja Form Footer) ja myös koko 
lomakkeella on omat ominaisuutensa. Nämä ominai-
suudet määritetään ominaisuuslomakkeen (property 
sheet) kautta napsauttamalla hiirellä ominaisuus-
lomaketta kuvaavaa ikonia . 

� Saat ominaisuuslomakkeen näkyviin myös napsautta-
malla hiirellä kahdesti haluamaasi kontrollikenttää. 
Pääset muuttamaan määrittelyjä myös napsaut-
tamalla kenttää hiiren oikeanpuoleisella napilla. 
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Jos haluat nähdä esimerkiksi jonkin kontrollikentän 
ominaisuudet, napsauta sitä ensin hiirellä (oikealla 
napilla) ja napsauta sitten ominaisuuslomakepainiketta.  

    

Lohkomäärittelyn ominaisuudet näet napsauttamalla 
ensin Form Header, Detail tai Form Footer -rivejä ja koko 
lomakkeen määrittelyt näet napsauttamalla ensin lomak-
keen oikeassa laidassa olevaa harmaata aluetta tai, jos 
viivain (ruler) on näkyvissä, viivaimen vasemmalla 
laidassa olevaa neliötä (katso esimerkki sivulta ). 

���� Viivain saadaan näkyviin komennolla View → Ruler 
(Näytä → Viivain). -merkki komennon edessä tar-
koittaa, että toiminto on voimassa. 

Accessissa on mahdollista määrittää ominaisuuksia lähes 
kaikille objekteille, ts. komponenteille (taulut, kyselyt, 
lomakkeet ja raportit) ja niissä sijaitseville kentille. Tutki 
asiaa napsauttamalla eri kohteita hiiren oikeanpuoleisella 
napilla: löydätkö Properties (Ominaisuudet) -komennon? 
Makroilla ja Visual Basicilla voidaan puolestaan määrätä 
eri objekteille uusia ominaisuuksia (katso esimerkkejä 
Laskutus-tietokannan makroista ja moduuleista).  

Kohteiden koon ja sijainnin muuttaminen 

Kohteiden koko muutetaan tarttumalla hiirellä kiinni 
johonkin näistä pienistä mustista pisteistä (osoitin 
muuttuu kaksipäiseksi nuoleksi ) ja liikuttamalla hiirtä, 
jolloin kohde muuttuu halutun kokoiseksi.  
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� Koska kentän koko muuttuu kohdetta liikuteltaessa 
helposti liian pieneksi, tarjoaa Access nopean tavan 
kohteen muotoilemiseksi. Kaksoisnapsautus (osoitti-
men ollessa kaksipäinen nuoli: ) pienissä mustissa 
kulmapisteissä muuttaa kohteen koon automaatti-
sesti korkeudeltaan ja leveydeltään vastaamaan 
kenttämäärittelyjä. Se vastaa Format-valikon komen-
toa Size > to Fit (Muotoile → Muuta kokoa > 
Sovittamalla). 

Kohde siirretään toiseen paikkaan viemällä hiiren osoitin 
kohteen päälle ja painamalla hiiren vasen nappi pohjaan 
ja vetämällä se hiirellä uuteen paikkaan. Osoitin muuttuu 
kämmeneksi  siirron ajaksi.  

Tekstikohteiden vasemmassa ylänurkassa oleva musta 
piste on muita pisteitä hieman suurempi ja sitä käytetään 
vain erikoistilanteessa: jos kontrollikenttä halutaan siirtää 
erillään kentän otsikkotekstistä. Esimerkiksi, jos haluat 
siirtää Katuosoite-kenttää ja haluat jättää kuitenkin 
tekstin Osoite paikoilleen, toimi seuraavasti: valitse 
siirrettävä kohde, vie hiiren osoitin kohteen (Katuosoite-
kentän, ks. kuva alla) vasempaan ylänurkkaan ja vedä 
kohde sormiosoittimella toiseen paikkaan.  

Ruudukko (Grid) 

Format-valikossa on oletusarvona Snap to Grid (Muotoile 
→ Kohdista ruudukkoon) -määritys "päällä", josta 
osoituksena komennon edessä näkyy -merkki. Grid eli 
ruudukko määrää, kuinka tarkasti eri kohteet asettuvat 
lomakkeessa. Voit halutessasi tarkistaa (ja muuttaa) 
ruudukon asetukset lomakkeen ominaisuuksista seuraa-
vasti: 

1. Valitse lomake Edit-valikon komennolla Select Form 
(Muokkaa → Valitse lomake). 
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2. Napsauta Ominaisuudet-työkalupainiketta  tai 
anna View-valikosta komento Properties (Näytä → 
Ominaisuudet). Katso tarkemmin sivulta . 

� Jos näkyvissäsi on asteikkoviivain (ruler), pääset 
kätevästi katselemaan ja muuttamaan lomakkeen 
ominaisuuksia kaksoisnapsauttamalla viivaimen 
vasemmassa laidassa näkyvää ruutua . 
Saat aikaan monivalinnan (multiple selection) kun 
maalaat tai napsautat viivaimen eri kohtia.  

3. Muuta Grid X ja Grid Y -arvot esim. luvuiksi 10, jos ne 
eivät ennestään ole. Tällöin yhtä mittayksikköä (1 cm) 
kohti on 10 kohdistuspistettä (siis kohteet asemoi-
tuvat 0,1 cm:n välein). 

Jos haluat jälkeenpäin tehdä kohteiden koon ja sijainnin 
hienosäätöä, valitse muutettavat kentät ja anna Format-
valikosta Size > to Grid (Ruudukon mukaiseksi) 
-komento tai Size > to Fit (Sovittamalla) -komento koon 
muuttamiseksi joko ruudukon tai esim. tekstikoon 
mukaiseksi. 

Kohteiden tasaus 

Kohteiden sijoittelu lomakkeelle on melko helppoa. Kun 
olet raahannut kohteet hiirellä suurin piirtein oikeisiin 
kohtiin, voit muuttaa kohteiden asetuksia lomakkeen 
ominaisuusmäärittelyistä ja Format- eli Muotoile-
valikosta. Seuraavassa kuvassa on selostettu pää-
piirteissään Format- eli Muotoile-valikon sisältämien 
komentojen merkitys. 
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Autoformat (Automaattinen muotoilu) 
Aseta oletusarvot valitusta kohteesta muistiin 
Muuta kontrollin tyyppi 

Asemoi kohteen ruudukon mukaisesti 
Valittujen kohteiden tasaus vasemmalle, oikealle,... 
Muuttaa kohteen kokoa mm. ruudukon mukaisesti 
Valittujen kohteiden välin vaakasuora tasaus 
Valittujen kohteiden välin pystysuora tasaus 

Tuo kohteen etualalle 
Vie kohteen muiden kohteiden taakse 

Jos haluat tasata esim. tekstikohteet vasemman laidan 
mukaisesti, valitse ensin kohteet lassoamalla (selostettu 
edellisessä luvussa) ja anna sen jälkeen Format-valikosta 
komento Align ja valitse Left. 

Valitse kohteet ensin vetämällä hiirellä  -osoittimella 
asteikkoviivaimen vasemmassa laidassa näkyvien nume-
roiden päällä. Anna sen jälkeen Format-valikosta komento 
Vertical Spacing (Pystysuora välistys), jonka oikealta 
puolen paljastuu kolme komentoa: 

• Make Equal muuttaa kohteiden välit samaksi 

• Increase suurentaa kohteiden välistä etäisyyttä 

• Decrease pienentää kohteiden välistä etäisyyttä 

Voit vastaavasti muuttaa vaakasuoraa välistystä 
valitsemalla kohteet ensin  -osoittimella asteikko-
viivaimen ylälaidassa ja valitsemalla sopivan vaihtoehdon 
Horizontal Spacing -kohdasta. 

���� Muista, että Edit-valikossa on komento Undo (Muok-
kaa → Kumoa) tai työkalurivillä painike , jos 
epäonnistuit ensimmäisellä yrittämällä. Ctrl+Z on 
vastaava pikanäppäin. Liitteessä 4 on tarkempi selitys 
eri työkaluista ja liitteessä 5 on yhteenveto 
pikanäppäinyhdistelmistä. 

Automaattinen muotoilu 

� Avaa lomake suunnittelutilaan  ja anna Format 
(Muotoile) -valikosta komento Autoformat (Auto-
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maattinen muotoilu). Se auttaa muuttamaan 
lomakkeen ulkoasua nopeasti. 

 

Lomake saa OK:n painalluksen jälkeen seuraavan-
kaltaisen ulkoasun: 

 

Lomakkeeseen on upotettu kuva, tässä tapauksessa 
Stone.bmp. Voit siis upottaa grafiikkaa lomakkeisiin 
(Picture-ominaisuus). Ota näkyviin lomakkeen suunnit-
telutilassa ominaisuudet-ikkuna, napsauta Format 
(Muotoilu) -kielekettä, siirry Picture (Kuva) -ominaisuuden 
kohdalle ja napsauta hiirellä -painiketta, jonka jälkeen 
voit valita jonkin taustakuvan. 

 

���� Grafiikka, varsinkin bittikarttakuvat (.BMP), kasvatta-
vat tietokannan kokoa huomattavasti (kymmeniä tai 
satoja kilotavuja)! 

���� Access ei sisällä kovin hyviä valmispohjia. Esimerkiksi 
edellä valitussa kuvassa näkyy vasemman laidan 
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tekstit ikäänkuin painikkeina, ja joku käyttäjistä 
saattaa erehtyä kuvittelemaan, että niitä 
napsauttamalla tapahtuu jokin toiminto! 

� Tee itse oman lomakepohjasi automaattinen muotoilu, 
jota käytät muiden lomakepohjien muotoilussa. Tee 
ensin yksi lomake, jossa on valittuna taustakuva ja 
muotoiltuna selitetekstit, varsinaiset tekstikentät, 
lomakkeen ylätunnistelohko (Header) ja siellä olevan 
otsikon tekstityyppi ym. määrittelyt. Anna sen jälkeen 
Format-valikon Autoformat-komento (Muotoile → 
Automaattinen muotoilu), napsauta Customize 
(Mukauta) -painiketta ja luo joko aivan uusi määrittely 
tai päivitä Accessin alkuperäinen määritys. 

 
Kun painat OK:ta, kysyy Access nimen muotoilullesi. 
Anna nimeksi esimerkiksi Oma, jonka jälkeen voit käyttää 
sitä uusien lomakkeiden pohjana. 

� Valitse selitetekstit ja ota niistä painikemaisuus pois. 

� Tee sen jälkeen oma lomakepohjamäärittelysi, kuten 
edellä neuvottiin. 

Kenttien muotoilu 

Muotoilutyökaluista löydät tuttujen tekstityypin ja -koon, 
lihavoinnin, kursivoinnin, alleviivauksen ja tasaus-
työkalujen lisäksi viisi muotoilutyökalua, joilla voit tehdä 
kohteille väri- ja viivamäärittelyt. Valitse ensin kohde tai 
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kohteet ja valitse sen jälkeen joko muotoilu suoraan 
napsauttamalla painiketta tai avaa lista  ja valitse 
muotoilu sieltä. 

Taustan Edustan
väri (tekstin) väri

Erikoistehoste

Reunaviivan  Viivan paksuus
väri

 

6.3 Lomakkeen tulostus 

Tallenna lomake ennen tulostusta File-valikon Save-
komennolla (Tiedosto → Tallenna) tai Ctrl+S näppäin-
komennolla (sivu 109).  

Lomake voidaan tulostaa joko suoraan File-valikon Print-
komennolla (Tiedosto → Tulosta) tai suositeltavammin 
ensin Print Preview (Esikatselu) -komennon kautta, jota 
vastaa  -painike.  

Esikatselun työkalut:  

� Katso, miltä lomake näyttää esikatselussa. Jos olet 
siihen tyytyväinen ja olet valmis kuluttamaan paperia, 
niin tulosta se. Lopeta esikatselu painamalla esim. 
Close (Sulje) -painiketta. 

� Sen jälkeen voit sulkea myös lomakkeen. 

6.4 Suodattimen käyttö 

Suodatin (filter) on pikakysely, johon voit antaa useita 
hakukriteereitä. Suodatin tehdään samalla määräämällä 
ehtoja (kenttiä ja/tai kenttien arvoja) lomakkeen, 
taulukon tai kyselyn normaalinäyttöön, mutta suodatti-
meen ei ole mahdollista lisätä tauluja tai laskentakenttiä 
(summia jne.). Suodattimeen voidaan määrittää siis 
ainoastaan haku- ja lajittelukriteerit. Suodatin tehdään 
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suodatustyökaluilla Suodatus valinnan mukaan (Filter By 
Selection) ja lomakesuodatus (Filter By Form). 

� Suodatus valinnan mukaan -työkalulla poimitaan 
valitun alueen mukainen näkymä, esimerkiksi osoite-
rekisterissä Kunta-kenttä.  

� Lomakesuodatustyökalulla voidaan nopeasti valita 
esimerkiksi vain tietyn postinumeron yritykset. 
Esimerkiksi jos Kunta-kenttään kirjoitetaan ehdoksi 
A*, Access muuttaa sen SQL-tyyppiseksi Like-
operaatioksi ja poimii kaikki A:lla alkavat kunnat. 

� Aseta/Vapauta suodatus -työkalu (Apply/Remove 
Filter).  

���� Suodatustyökalut ovat käytössä myös kyselyille ja 
tauluille. 

Esimerkki 1: on poimittava kaikki helsinkiläiset yritykset. 

� Etsi ensin yksi helsinkiläinen yritys ja napsauta 
hiirellä postitoimipaikkakentässä. Napsauta Filter By 
Selection  -työkalua ja homma on valmis! 

� Poistu suodatustilasta painamalla -työkalua. 

Esimerkki 2: on poimittava yritykset, joiden toimiala liittyy 
ohjelmointiin, kuntana on OULU ja postinumeroalue on 
välillä 90530– 90570. 

� Ota käyttöön Filter By Form  ja valitse joko listasta 
kentän oikealta puolelta tai kirjoita seuraavat ehdot: 

Asiakasryhmä: Ohj* 
Kunta: OULU 
Postinumero: Between 90530 And 90570 

Voit muokata kyselyehtoja Zoom-ikkunassa (Shift + F2): 

 

� Paina suodatustyökalua , jolloin saadaan Filter By 
Form näkymä. Siinä ovat käytössä lisätyökalut: 

. Suodatusta varten on lisäksi Records-

valikossa Filter-komento: 
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� Vapauta suodatus lopuksi painamalla . 

6.5 Lomakkeen muuttaminen helppokäyttöisemmäksi 

Muuttaaksesi lomaketta käyttäjäystävällisemmäksi sinun 
tulee mm. siirtää kenttiä paikasta toiseen ja tehdä 
pudotuslistoja (combo box), valintakytkinryhmiä (Option 
groups) ja komentopainikkeita (command buttons). Ne 
kaikki voidaan loihtia ohjatusti velhoa käyttäen. 

Seuraavassa harjoituksessa lähdetään tekemään 
pudotuslistaa, josta asiakasryhmä voidaan valita suoraan 
ilman, että sitä pitäisi muistaa ulkoa. 

Pudotuslistan tekeminen 

Normaalisti pudotuslista (combo box, yhdistelmäruutu)  
tehdään silloin, kun 

• kenttä sisältää useita vaihtoehtoja, jolloin niiden muis-
taminen ulkoa on vaikeaa ja sen sisältö saattaa muut-
tua tulevaisuudessa; tällöin tieto haetaan jostakin tau-
lusta kentän arvoksi → nk. sidottu kenttä (bound 
control) 

• listan kautta halutaan etsiä oikea tietue (ks. myös s. 
126) → nk. vapaa kenttä (unbound control) 

���� Tauluihin ja kyselyihin tehdyt Lookup-kentät (s. 95) 
periytyvät lomakkeille esimerkiksi pudotuslistoina 
(combo box). Voit myös muuttaa kentän ulkoasu-
tyyppiä muun muassa tavallisesta tekstikentästä 
pudotuslistaksi. 

� Avaa LASKU1.MDB. Muuta Asiakastiedot-lomakkeen 
Asiakasryhmä-kenttä pudotuslistaksi eli yhdistetyksi 
tekstilistakentäksi (combo box eli drop-down list box), 
jotta voisit sen kautta hakea uudelle asiakkaalle 
asiakasryhmän tietokantaan jo talletetuista asiakas-

Monipuolisin 
suodatus 
tapahtuu 
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ryhmistä (tai vaihtaa olemassaolevaa asiakasryhmää). 
Pudotuslista näyttää kaikki mahdolliset vaihtoehdot, 
kun painat pudotuslistapainiketta .  

���� Vaikka Access sallii kontrollikentän tyypin (esim. 
tekstikentästä pudotuslistaksi) vaihtamisen suoraan 
(Format → Change To), on pudotuslistaan kuuluvan 
hakukyselyn tekeminen hieman helpompi tehdä 
velhoa käyttäen. Poistetaan siis ensin vanha 
kontrollikenttä: 

1. Valitse Asiakasryhmä-kenttä napsauttamalla sitä. 

2. Poista kenttä painamalla Delete-näppäintä. 

Sen jälkeen valitaan oikea työkalu ja haetaan taulu-
määrittelystä siihen oikea kenttämäärittely. Sidottu 
pudotuslista tehdään seuraavasti: 

1. Napsauta pudotuslista-työkalua  työkalulaatikosta. 

2. Napsauta kenttälista-painiketta  yläpuolen työkalu-
palkissa. Näkyviin tulevat kaikki ASIAKAS-taulun 
kentät. 

3. Tarkista, että velhotyökalu  on painettuna pohjaan. 
Vedä hiirellä (vasen nappi pohjassa) Asiakas-
ryhmä-kenttä lomakkeeseen (paikkaan, jossa Asiakas-
ryhmä-kenttä aikaisemmin sijaitsi). Osoitin muuttuu 
vetämisen ajaksi: . 

4. Vapauta hiiren vasen nappi, jolloin Accessin Pudotus-
listavelho (Combo Box Wizard) kysyy muutaman 
kysymyksen, mm. haluatko, että listan sisältö 
perustuu johonkin tauluun tai kyselyyn vai että 
kirjoitat itse mahdolliset vaihtoehdot, jotka tulevat 
listaan näkyviin. Kolmas vaihtoehto on etsiä jokin 
tietue tietokannasta. Koska tässä tapauksessa lista 
muodostetaan ASIAKAS-taulusta, paina Next 
(Seuraava). 
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5. Seuraavassa ruudussa sinun pitää valita taulu tai 

kysely, josta lista muodostetaan. Valitse ASIAKAS-
taulu. 

6. Seuraavaksi valitset kentät, joista lista muodostetaan. 
Valitse Asiakasryhmä (kaksoisnapsauttamalla sitä). 

 
Tämän jälkeen Pudotuslistavelho näyttää taulun sisäl-
tämät tietueet ja pyytää sinua määräämään sarakkeiden 
leveyden. Kaksoisnapsauta sarakkeiden otsikoiden oikeal-
la puolella, jolloin sarake 1 (Col 1) muuttuu leveimmän 
tiedon levyiseksi (voit myös leventää saraketta kaksi 
vetämällä hiirellä otsikon oikeasta laidasta oikealle). 

7. Pudotuslistavelho kysyy seuraavaksi, mihin kenttään 
tallennat sen tiedon, mikä listasta valitaan. Valitse 
Asiakasryhmä. 

8. Sitten sinun pitää vielä valita, haluatko tallentaa 
tiedon muistiin myöhempää käyttöä varten (esim. 
tietueen hakemiseksi näytölle, ks. s. 126) vai 
haluatko, että listasta valitsemasi tieto tallentuu ko. 
kenttään (ts. lisäät tai muutat ko. kentän arvoa). 
Valitse jälkimmäinen: 

 
9. Viimeinen vaihe on tekstikentän nimen antaminen; 

anna nimeksi sama kuin varsinaisella kentällä eli 
Asiakasryhmä. 

10. Paina Finish (Valmis) ja vasta tämän jälkeen 
pudotuslista ilmestyy näytölle. 
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3. Napsauta hiirellä listan ulkopuolella, jolloin lista ei ole 
enää valittu.  

• Kätevimmin teet uuden kontrollikentän lomakkeelle (ja 
jatkossa myös raportille) napsauttamalla ensin oikeata 
työkalua ja vetämällä sitten tarvitsemasi kenttä 
kenttälistasta lomakkeeseen halutulle paikalle. 

Teit edellä kaksisarakkeisen pudotuslistan. Tämän 
jälkeen voit muuttaa kohteen ominaisuuksia esim. siten, 
että pudotuslista sisältää useampiakin sarakkeita. 

� Testaa tekemäsi listan toimivuutta. 

4. Näytön alareunassa (tilarivillä) näkyvät taulumäärit-
telyissä kirjoitetut kenttäkuvaukset. Niistä on joskus 
todellakin apua.  

Tietojen etsintä (pudotuslistan avulla) 

Eräs yleisimpiä tietokantasovelluksessa tarvittavia toimin-
toja on helposti tehtävien hakujen muodostaminen. 
Accessissa tämä tehdään pudotuslistan (combo 
box) kautta, kuten jo sivulla 123 opittiin.  

Tehdään ensin haku-pudotuslista yhdelle 
sarakkeelle: 

5. Valitse yhdistelmäruutu (Combo Box), ja 
napsauta lomakkeessa kohtaa, johon 
kontrolli halutaan asemoida. 

6. Sinulla on kolme vaihtoehtoa pudotuslistan 
sisällöksi. Valitse niistä alimmainen, jolla etsitään 
lomakkeen tietue yhdistelmäruudusta valitun arvon 
perusteella. Paina Next- eli Seuraava-painiketta. 

7. Valitse Asiakkaan nimi -kenttä: 
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8. Sovita näytölle tulevan listauksen leveys vetämällä 
hiirellä taulukon oikeata reunaa.  

• Levennä sarake hieman leveämmäksi kuin tieto-
kannasta löytynyt levein tieto (tulevaisuuden varalta). 

9. Kirjoita seliteteksti toiminnolle (esim. Etsi: tai Haku:) 
ja paina Finish eli Valmis:  

Pudotuslistan muotoilu 

Suositus: siirrä hakukontrolli ja selite lomakkeen 
alalaitaan (alatunnisteeseen) erilleen tietojentalletus-
kentistä. Kun siirrät kontrollia tarkista, että näkyy musta 
käsi: se tarkoittaa, että sekä kontrolli että sen selite 
aktivoituvat ja että ne hiirellä vetämällä siirtyvät yhtä 
aikaa. Jos valitset pelkästään vasemmassa yläkulmassa 
näkyvän mustan neliön, niin vain kyseinen kontrolli 
aktivoituu! 

Mukauta Haku-seliteteksti valitsemalla hiirellä Haku-
selite-kontrolli ja anna komento Muotoile → Muuta 
kokoa > Sovittamalla. 

• Sama toiminto hiirellä: napsauta selitetekstikontrollia 
kerran, siirrä kursori kontrollin oikeaan alanurkkaan ja 
napsauta kahdesti. 

• Voit valita useampia selitetekstikontrolleja pitämällä 
Ctrl-näppäintä alhaalla, valitsemalla ne hiiren 
vasemmalla napilla ja lopuksi klikkaamalla kahdesti 
yhden kontrollin oikeaa alakulmaa. Kaikki valitut 
kontrollit asemoituvat! 

Valitse pudotuslistakontrolli ja tarkastele sen ominai-
suuksia (Other- eli Muut-kieleke): 
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Muuta halutessasi tilarivin tekstiksi esim. Selaushaku ja 
ohjausobjektivihjeeksi sama teksti (kopioi se Ctrl+C:llä ja 
liitä Ctrl+V:llä).  

Pudotuslistan sisällön muokkaus 

Lisätään lomakkeella olevaan hakupudotuslistaan toinen 
sarake, koska meitä kiinnostaa selauksessa myös 
paikkakunta. Räätälöinti tehdään jo luotuun Haku-
kontrolliin muuttamalla sen ominaisuuksia. Pudotus-
listalle on tärkeätä määritellä rivilähde, sidossarake ja 
sarakkeiden lukumäärä. Tarkastellaan aluksi näitä. 
Rivilähde (Row Source) voidaan muokata graafisesti: paina 
sen oikeassa laidassa näkyvää -painiketta. 

 

Kaksoisnapsauta Postitoimipaikka-kenttää, jolloin se 
”hyppää” viimeiseksi sarakkeeksi kyselyyn (tai vedä se 
sinne hiirellä). 

 

Sulje kyselynäkymä, jolloin rivilähteen SQL-teksti 
muuttuu. SQL-tekstiä voidaan myös muokata suoraan 
itse. Teksti saadaan parhaiten näkyviin Zoom-toiminnolla. 
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Napsauta hiirellä rivilähde-kohtaa ja paina Shift+F2-
näppäinyhdistelmää. 

Rivilähteen koodina on SQL-lause:  

SELECT DISTINCTROW [ASIAKAS].[Asiakastunnus], 
[ASIAKAS].[Asiakkaan nimi], [ASIAKAS].[Postitoimipaikka] 
FROM [ASIAKAS];  

Seuraavaksi muutetaan Haku-kontrollin sarakkeiden 
määräksi 3, lisätään sarakeleveyteen puolipiste ja 
lukuarvo, (senttimetrimitta, jonka Access muuttaa 
sisäisesti tuumayksiköiksi ja se näkyy joskus näytöllä 
pienenä muutoksena kirjoitettuun arvoon verrattuna). 
Muista lisätä luettelon leveyttä vastaavasti. 

� Laittamalla 0 cm sarakeleveydeksi saadaan avain-
kenttä piiloon näytöltä. 

  

Jos pienennät muutettuja lukuarvoja hiukan, saat listasta 
kapeamman. 

 

• Hakulistan rivilähteenä voi olla myös talletettu kysely 
tai taulukko; siitä voidaan poimia halutut sarakkeet.  
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Pudotuslistavaihtoehdot 

Pudotuslista voi sisältää yhden tai useamman sarakkeen. 
Näitä kahta vaihtoehtoa on käsitelty seuraavissa 
alaluvuissa. 

Kaksi- tai useampisarakkeinen pudotuslista 

Jos lomakkeeseen halutaan jonkun avaimen (esim. 
Asiakastunnus) lisäksi näkyviin kenttä, joka näkyy listassa 
toisena (esimerkiksi Asiakkaan nimi), pitää lomakkeen 
perustua kyselyyn, johon ko. kenttä on otettu mukaan. 
Tärkeätä on valita kyselyyn nimenomaan kenttä, joka on 
viiteavaimena. 

LASKU-taulusta poimittu viiteavain
ASIAKAS-taulusta poimittu kenttä  

Esimerkiksi jos haluat Lasku-lomakkeeseen pysyvästi 
näkyviin sekä asiakastunnuksen että asiakkaan nimen, 
pitää sinun tehdä LASKU- ja ASIAKAS-taulut sisältävä 
kysely. Kyselyyn otetaan mukaan kaikki kentät LASKU-
taulusta (myös Asiakastunnus) ja ainoastaan Asiakkaan nimi 
-kenttä ASIAKAS-taulusta.  

���� Jos muutat jälkeenpäin jonkin tauluun perustuvan 
lomakkeen ominaisuuksia, toimi seuraavasti. Tee 
kysely, kuten edellä kerrottiin, ja tallenna kysely esim. 
nimellä Lasku-Asiakas. Avaa tämän jälkeen lomake 
suunnittelutilaan, valitse lomake (Edit → Select Form) 
ja muuta Record Source -kohtaan tekemäsi kysely, 
esim. Lasku-Asiakas. Vasta sitten voit poimia kenttä-
listasta Asiakkaan nimi -kentän ja vetää sen hiirellä 
lomakkeeseen. 

Monisarakkeinen pudotuslista muodostetaan joko 
Pudotuslistavelholla tai SQL-lauseella Select ... From, 
johon kirjoitetaan listaan tulevat kentät. Esimerkiksi jos 
haluat pudotuslistaan näkyviin ASIAKAS-taulusta 
Asiakastunnus ja Asiakkaan nimi -kenttien lisäksi vaikkapa 
puhelinnumeron, muuta Asiakastunnus-kentän ominai-
suuksia: 
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Huomaa Row Source Type (Rivilähteen tyyppi) -asetus ja 
erityisesti Row Source (Rivilähde) -asetus, jossa on SQL-
lause. Viittaukset tauluihin ja taulujen kenttänimiin 
voidaan kirjoittaa myös pienillä kirjaimilla (esim. asiakas). 
Jos kentän nimi koostuu kahdesta tai useammasta 
sanasta, kuten Asiakkaan nimi, pitää kentän nimen 
ympärille laittaa hakasulut. 

Column Count (Sarakkeiden määrä) pitää olla 3, koska 
listassa on kolme saraketta. Column Widths (Sarakeleveys) 
-kohtaan pitää antaa leveydet sentteinä, esim. 1;4;2 
(puolipiste erottaa mitat toisistaan). List Width (Luettelon 
leveys) pitää asettaa vastaamaan sarakeleveyksiä 
(1+4+2=7). 

Limit to List (Vain luettelon käyttö) -kohtaan voidaan valita 
"Yes", jos lista halutaan rajoittaa koskemaan ainoastaan 
tietokannassa jo olevia asiakkaita. Jos se olisi "No", olisi 
LASKU-tauluun mahdollista (teoriassa) lisätä sellaisia 
asiakastunnuksia, joita ei ASIAKAS-tauluun ole vielä 
lisätty. Edellytyksenä lisäyksen onnistumiselle on, että 
LASKU- ja ASIAKAS -taulujen välille ei ole tehty 
riippuvuutta eikä lomakkeessa esiinny ASIAKAS-taulusta 
yhtään kenttää (esim. asiakkaan nimeä). Jos yhteys on 
muodostettu, näytölle tulee tietueita lisättäessä tai 
muutettaessa jokin virheilmoitus. 

SQL-lauseessa voi olla mukana myös order by, jos lista 
halutaan lajitella asiakkaan nimen mukaiseen aakkos-
järjestykseen. Jos se puuttuu, tiedot lajittellaan perus-
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avaimen eli tässä tapauksessa asiakastunnuksen 
mukaan. Koko SQL-lause olisi tällöin:  

Select Asiakastunnus, [Asiakkaan nimi] From ASIAKAS order by 
[Asiakkaan nimi]; 

• Voit muodostaa SQL-lauseen siirtymällä pudotuslista-
kentän Row Source -kohtaan ja napsauttamalla 
oikeassa laidassa näkyvää  -painiketta. Näytölle 
ilmestyy Query Builder, johon voit muodostaa 
haluamasi kyselyn. 

 
Kuva 11. Lasku-lomakkeen henkilölistaan tarvittu SQL-
lause on muodostettu kyselyn rakentajaa apuna käyttäen. 

� Sulje ja tallenna lomake. Kokeile sen jälkeen, kuinka 
tekemäsi muutos onnistui.  

Yksisarakkeinen pudotuslista  

Yksisarakkeinen pudotuslista voidaan muodostaa monella 
eri tavalla. Jos pudotuslista muodostetaan jonkin taulun 
ensimmäisestä kentästä, Row Source (Rivilähde) -kohtaan 
tarvitsee kirjoittaa ainoastaan taulun nimi, josta sarake 
muodostetaan.  

Seuraavassa esimerkissä haetaan kaikki Asiakas-
tunnukset, jotka ASIAKAS-tauluun on syötetty: 
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Jos pudotuslista muodostetaan jostakin muusta kentästä 
kuin taulun perusavaimesta, Row Source -kohtaan 
kirjoitetaan SQL-lause. Alla olevassa esimerkissä 
muodostetaan lista kaikista kunnista, jotka HENKILO-
tauluun on syötetty: 

 
Pudotuslista voidaan muodostaa myös ilman hakua 
mistään taulusta. Tällöin pitää Row Source Type 
(Rivilähteen tyyppi) muuttaa Value List (Arvoluettelo) 
-tyyppiseksi ja Row Source (Rivilähde) -kohtaan pitää 
kirjoittaa vaihtoehdot puolipisteellä erotettuina. Seuraa-
vassa esimerkissä tehdään lista eri tutkinnoista: 

 

Milloin pudotuslistaa ei muodosteta 

Seuraavassa on pari tilannetta, joissa pudotuslistaa ei 
yleensä käytetä: 

• Jos kenttä on sellainen, että se ei saa sisältää samaa 
arvoa kahdessa eri tietueessa (ts. kentän ominaisuuk-
sissa on No Duplicates). Esimerkiksi Henkilötunnus 
HENKILO-taulussa tai Asiakastunnus ASIAKAS-taulussa. 

• Olet tehnyt kyselyn ja valinnut kyselyalustaan eri tau-
lujen perusavaimia. Tällöin kenttä on sidottu toiseen 
tauluun etkä voikaan valita listasta eri vaihtoehtoja 
(näytön alalaitaan tulee virheilmoitus This field is 
bound to ...). 

Vaihtoehtoryhmän muodostaminen 

Tässä harjoituksessa tehdään seuraavan-
lainen vaihtoehtoryhmä (option group):  

���� Jos näytöllä on ennestään kenttä, josta 
vaihtoehtoryhmä halutaan muodostaa, 
pitää se poistaa (ensin se valitaan 
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napsauttamalla ja sitten se poistetaan Delete-näppäi-
mellä). Jos näin ei toimita, ei Access osaa nimetä 
vaihtoehtoryhmää kentän nimellä ja joutuisit jälkeen-
päin kirjoittamaan itse otsikon Laskun tila. 

� Poista Laskun tila -kenttä. 

1. Ota työkalut ja kenttälista esille, jos niitä ei näytöllä 
näy: View → Field list (Näytä → Kenttäluettelo) ja 
View → Toolbox (Näytä → Työkaluryhmä). 

2. Napsauta vaihtoehtoryhmätyökalua , valitse oikea 
kenttä (Laskun tila) ja vedä kenttä hiiren vasen nappi 
pohjassa lomakkeeseen haluttuun paikkaan. Näin 
kopioituvat kaikki kentän taulumäärittelyt lomak-
keeseen. Ryhmälaatikon nimeksi tulee automaatti-
sesti Laskun tila. 

Jos velhotyökalu  on “päällä” (ts. painettuna pohjaan), 
käynnistyy ohjattu vaihtoehtoryhmän luominen. Ensim-
mäisenä vaihtoehtoryhmävelho kysyy tekstit, jotka tulevat 
eri vaihtoehtoihin.  

3. Kirjoita kukin rivi kerrallaan ja paina Enteriä rivin 
lopussa. Kun kaikki vaihtoehdot on kirjoitettu, paina 
Next (Seuraava) -painiketta. 

 
4. Valitse sen jälkeen kenttä, joka on oletusarvona. 
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5. Tämän jälkeen määrätään arvot, jotka asetetaan eri 

vaihtoehdoille. Hyväksy oletukset painamalla Enteriä. 

6. Myös seuraava ehdotus on tässä tilanteessa oikein. 
Velho kysyy, haluatko tallentaa valitun vaihtoehdon 
ko. kentän arvoksi tauluun vai haluatko käyttää sitä 
esim. tietojen haussa myöhemmin. Yleensä arvo 
tallennetaan tauluun. Hyväksy oletuksena oleva 
Laskun tila -kenttä Enterillä. 

 
7. Seuraavaksi sinun pitää valita vaihtoehtoryhmän 

tyyli. Suosittelen Etched tai Sunken (Upotus) -tyyliä. 
Voit myös vaihtaa kentän ulkoasun tarkistusruuduksi 
tai valintapainikkeeksi.  

  
8. Viimeinen askel on antaa otsikko vaihtoehtoryhmälle. 

Otsikoksi riittää pelkkä Tila. 

9. Paina lopuksi Finish (Valmis) -painiketta. 
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Kelpoisuussäännöt 

Access tarkistaa kentän oikeellisuuden, silloin kun 
kentästä poistutaan (siirrytään toiseen kenttään) tai 
lomake suljetaan. Jos kentän sisältämää tietoa ei 
muuteta, ei myöskään kentän oikeellisuutta tarkisteta. 
Normaali tapa on kirjoittaa kentän ominaisuusmääritte-
lyjen Validation Rule ja Validation Text -kohtiin kelpoisuus-
sääntö ja teksti, joka ilmestyy näytölle, jos sääntöä 
rikotaan. Seuraavassa esimerkissä on LASKURIVI-taulun 
Kpl-määrä -kentän kelpoisuussääntö ja -teksti: 

 
���� Jos teet kelpoisuussäännöt jo taulujen perustamis-

vaiheessa, periytyvät ne myös lomakkeisiin. Jos laitat 
kelpoisuussäännöt taulujen kenttiin lomakkeiden 
teon jälkeen, pitää sinun kirjoittaa kelpoisuussäännöt 
erikseen myös lomakkeisiin. 

� Tee päivämäärän tarkistusrutiini jossa tarkistetaan, 
ettei laskua yritetä syöttää edellistä vuotta vanhem-
pana.  

Tällöin Validation Rule -kohtaan tulee rajaus jonka mukaan 
Year([Laskun pvm])>=(Year(Date())-1). Jos kenttään 
syötetään väärä päivämäärä, Access antaa virhe-
ilmoituksen. Sen sisältö on Validation Text -kohdassa, 
esim. Lasku pitää päivätä tälle tai viime vuodelle! (kuva ). 

 
Kuva 12. Mahdollisuus antaa oletusarvoja ja kelpoisuus-
sääntöjä on erittäin tärkeää. 

Jos haluat tehdä lomakekohtaisia (tietuekohtaisia) tarkis-
tuksia, pitää ne tehdä makrolla, jota kutsutaan joko 
lomakkeessa olevan kentän On Exit (Poiston yhteydessä) 
tai Before Update (Ennen päivittämistä) -kohdasta (asiasta 
lisää sivulla ). 
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���� Jos haluat, ettei Lasku yhteensä -kenttään voida siirtyä 
esim. hiiren napsautuksella, pitää sinun muuttaa 
kentän ominaisuusmäärittelyjen Enabled-kohta No 
-arvoksi. Tästä on valitettavasti seurauksena, että 
kenttä näkyy harmaana eikä se välttämättä ole kovin 
järkevää. 

� Lisää uusi kenttä  -työkalulla vaikkapa Maksun pvm 

-kentän perään (napsauta kerran hiirellä  -osoitti-
mella). Näkyviin tulee seuraavankaltainen kenttä: 

.  

� Poista FieldXX napsauttamalla sitä kerran hiirellä ja 
painamalla Delete-näppäintä. Napsauta sitten 
Unbound-kenttää kahdesti ja kirjoita seuraavat tekstit: 

 

Laskukaava kirjoitetaan siis yhteen "pötköön". 
Selkeämmin esitettynä se on seuraava: 

 =IIf([Laskun pvm]+[Maksuaika]<Date(); 
  IIf([Laskun tila]=2; 
   "Maksu on myöhässä!"; 
   " "); 
  " ") 

Suomeksi: jos eräpäivä on jo mennyt umpeen ja jos lasku 
on jo tulostettu, tulee näytölle teksti "Maksu on 
myöhässä!", muutoin näytölle ei tule ilmoitusta. 

� Muuta MaksuMyöhässä-kentälle myös värimäärit-
telyt: teksti (text) punainen, tausta eli täyttöväri (fill) 
lomakkeen värinen eli harmaa; samoin laatikon 
reunaviiva (border).  

� Kun olet saanut Lasku-lomakkeen kuntoon, sulje ja 
tallenna se. Avaa se ja kokeile tiedon syöttöä eri 
kenttiin. 

���� Lasku-lomakkeen Huomautukset-laatikon 2. ja 3. rivi 
päästään kirjoittamaan painamalla Ctrl+Enter rivin 
lopussa. 
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� Käy seuraavaksi tutkimassa ja muuttamassa 
Laskurivit-lomakkeen ominaisuuksia. Siirry ensin 
Lasku-lomakkeen suunnittelutilaan. 

• Pääset kaksoisnapsauttamalla alilomaketta suoraan 
alilomakkeen suunnittelutilaan. 

Laskurivit-lomake perustuu kyselyyn Laskurivi-tuote (voit 
todeta sen valitsemalla lomakkeen Edit → Select Form 
-komennolla ja katsomalla sen jälkeen lomakkeen ominai-
suuksia Record Source -kohdasta). 

• Tuotekoodi-kentässä on Row Source (Rivilähde) 
-kohdassa seuraava rivi: select distinctrow Tuotekoodi, 
[Tuotteen nimi] from TUOTE; 

���� Tuotteen nimi on hakasulkeissa, koska siinä on 
mukana välilyönti. 

• Jos haluat vaikuttaa päälomakkeessa olevan 
alilomakkeen jonkin kontrollikentän ominaisuuksiin, 
esim. pudotuslistan leveyteen, pitää sinun muuttaa 
nimenomaan alilomakkeessa olevan pudotus-
listakentän leveyttä (List Width -kohta).  

���� Alilomakkeeseen tehdyt muutokset tulevat voimaan 
vasta, kun alilomake suljetaan ja talletetaan. 

Voit tehdä itse nk. laskennallisia kenttiä, joiden sisältö 
määräytyy eri kenttiin kohdistuvien laskutoimitusten 
kautta. Näitä laskennallisia kenttiä voit tehdä esim. 
kyselyihin, lomakkeisiin ja raportteihin. 

• Kyselyssä Laskurivi-Tuote on viimeisenä kenttänä 
laskennallinen kenttä:  

Netto: [Hinta] * [Myyty kpl] -
 [Hinta]*[Myyty kpl]*[Alennus%]/100 

• Yht-kenttä saadaan kaavalla =Sum([Netto]). Sillä 
lasketaan laskuriveiltä rivien loppusummat em. Netto-
kenttää käyttäen 
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���� Yht-kentän nimeä tarvitaan päälomakkeessa Lasku. 
Ilman sitä ei saada laskurivien summaa Lasku-
lomakkeeseen. 

6.6 Komentopainikkeen tekeminen 

Jos haluat tehdä lomakkeeseen nopeasti jonkin komento-
painikkeen, luo Access sen automaattisesti komento-
painikevelholla. Painikkeen takana on Visual Basic 
-koodia. Tehdään esimerkiksi Asiakastiedot-lomakkeeseen 
painike, joka sulkee lomakkeen.  

� Avaa LASKU2.MDB ja siirry Asiakastiedot-lomakkeen 
suunnittelutilaan. Katso, että työkaluissa on pohjaan 
painettuna .  

1. Valitse työkaluryhmästä komentopainiketyökalu . 
Velho käynnistyy, kun Control Wizard (Ohjattu 
objektin luominen) -painike on alhaalla .  

2. Napsauta sen jälkeen paikkaa lomakkeessa, johon 
painike halutaan.  

Suositus: painikkeet sijoitetaan yleensä alhaalle tai 
oikealle. Paras paikka Sulje-painikkeelle lienee lomakkeen 
oikeassa alanurkassa, joten napsauta lomakkeen 
alatunnisteen (form footer) alapuolella. 

3. Valitse ensin vasemmasta listasta Form Operations 
(Lomaketoiminnot), jonka jälkeen pääset valitsemaan 
oikealta Close Form (Sulje lomake) -vaihtoehdon. 
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���� Categories-listassa on yleisimmät tarvittavat luokat. 
Regord Navigation -kohdassa on toiminnot tietueesta 
toiseen siirtymiseen ja Record Operations -kohdasta 
voit valita mm. tietueen lisäys- ja poistorutiinin. 
Application-luokasta voit valita painikkeen, jolla 
käynnistetään esim. Excel tai Word. Miscellaneous 
sisältää sekalaisia toimintoja. 

4. Paina Next (Seuraava) -painiketta ja pääset joko 
kirjoittamaan jonkin tekstin painikkeen sisällöksi tai 
valitsemaan jonkin kuvan painikkeelle. Koska 
grafiikan käyttö on käyttäjäystävällisempää, hyväksy 
oletuskuva painamalla Next. 

 

���� Kuvakkeita voidaan valita joko Accessin omista 
malleista tai muista bittikartta- (*.BMP) tai ikoni-
tiedostoista (*.ICO). Muista kuitenkin, että grafiikan 
käyttö vie aina jonkin verran enemmän muistia kuin 
pelkkä teksti. 

5. Kirjoita seuraavaksi painikkeelle kuvaava nimi. Tämä 
auttaa myöhemmin tarkastelemaan Moduuli-ikku-
nassa, mihin objektiin tapahtumakoodit liittyvät.  

� Suositus: kirjoita painikkeen nimen eteen ammatti-
ohjelmoijien käyttämä cmd, jolloin esim. Sulje-painikkeen 
nimeksi tulee cmdSulje (tai cmdClose). 

6. Kun painat Finish (Valmis) -painiketta, luo velho 
painikkeen ja sille tapahtumakoodin. 

• Jos teet graafisen painikkeen, suosittelemme painik-
keen alle kirjoitettavaksi mitä painike tekee (s. 142). 
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Voit tehdä myös avustetekstin (Control Tip Text), joka 
näkyy painiketta osoitettaessa (s. 141). 

7. Tallenna lomake ja kokeile uutta painikettasi (siirry 
ensin lomakenäyttöön). 

Painikkeen takana olevan koodin tarkastelu 

Nopein tapa tutkia painikkeen takana oleva koodia on 
napsauttaa tekemääsi komentopainiketta hiiren 
oikeanpuoleisella napilla ja valita näkyviin tulevasta 
valikosta komento Build Event (Muodosta tapahtuma). 
Access loi seuraavan Visual Basic -koodin: 

Private Sub cmdClose_Click() 
On Error GoTo Err_cmdClose_Click 
    DoCmd.Close 
Exit_cmdClose_Click: 
    Exit Sub 
Err_cmdClose_Click: 
    MsgBox Err.Description 
    Resume Exit_cmdClose_Click 
End Sub 

Sulje koodi-ikkuna, jonka jälkeen tehdään painikkeelle 
avusteteksti. 

Avustetekstin lisääminen kontrolliin 

Avusteteksti näkyy käyttäjälle ohjetekstinä silloin, 
kun hiiriosoitin on kontrollin (esim. painikkeen) 
päällä. Avusteteksti lisätään ja sitä muutetaan 
seuraavasti: 

1. Paina ominaisuudet-työkalua  tai anna komento 
View → Properties (Näytä → Ominaisuudet).  

2. Valitse Other (Muut) -kieleke ja korvaa halutessasi 
velhon luoma ControlTipText (Ohjausobjektivihje) 
-kohdan teksti:  
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3. Tallenna lomake ja testaa sitä lomakenäkymässä 
painamalla painiketta. Jos et ole tallettanut 
lomaketta, Access huomauttaa sinua siitä. 

Suunnittelutilassa painike voidaan siirtää haluttuun 
paikkaan hiirellä vetämällä ja sen kokoa voidaan muuttaa 
tarvittaessa vetämällä hiirellä painikkeen kulmapisteistä.  

Tekstin liittäminen komentopainikkeeseen 

Jos haluat tehdä sovellukseen ”oikeaoppisen” 
käyttöliittymän, pitäisi graafisessa painikkeessa 
näkyä myös painikkeen toimintaa selittävä teksti. 
Tämä saadaan aikaan seuraavasti: 

1. Siirry lomakkeen rakennenäkymään. Valitse A-
työkalu, napsauta jossakin kohtaa lomakkeessa ja 
kirjoita komentopainikkeen teksti, esim. &Sulje 
(muista &-merkki). 

2. Poistu tekstikontrollista napsauttamalla kerran sen 
ulkopuolella. 

3. Valitse kirjoittamasi tekstikontrolli napsauttamalla 
sitä nuoliosoittimella kerran ja leikkaa se muistiin 
(Ctrl+X). 

4. Napsauta komentopainiketta kerran. 

5. Liitä se painikkeeseen (Ctrl+V). 

Huono puoli painikkeen toimintaa selittävässä tekstissä 
on sen viemä tila näytöltä. Etuna on tekstin mukaan 
tuleminen kopioitaessa painike toiseen lomakkeeseen. 
Valitettavasti painikkeen takana oleva koodi ei kopioidu, 
vaan joudut kopioimaan sen erikseen.  
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6.7 Päävalikon tekeminen sovellukseen 

Tässä luvussa selostetaan, kuinka tietokannan avaamisen 
yhteydessä näkyviin tuleva päävalikko toteutetaan. 
Periaate on lyhyesti seuraava. 

1. Luo uusi lomake (Lomakkeet => Uusi). 

 
1. Paina OK, jolloin mitään taulua tai kyselyä ei tule 

lomakkeen pohjaksi. 

2. Lisää sen jälkeen komentopainikkeet (ohjeet luvussa 
6.6). 

3. Tee muutokset lomakkeen ominaisuuksiin 

• Muokkaa - Valitse lomake (Ctrl + R) 

• Näytä - Ominaisuudet 

• muuta asetus "Siirtymispainikkeet: Ei" (navigation 
buttons: No) ja poista halutessasi näkyvistä myös 
rullausjanat (scroll bars) ja tietuevalitsin (record 
selector). Ikkunan kokoa ei tarvitse muuttaa, joten 
Border Style voi olla Dialog. Koska Pienennä- ja 
Laajenna-painikkeita ei tarvita, muuta Min Max 
Buttons –kohtaan None. Seuraavissa kuvissa näkyy 
suositeltavat asetukset. 
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4. Tallenna lomake nimellä Valikko. 

5. Tools-valikon Startup-komennolla (Työkalut → 
Käynnistys) määrätään, että Valikko-niminen lomake 
avataan tietokannan avaamisen yhteydessä 
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� Paina Shift-näppäin pohjaan, jos haluat, että sovellus 
ei suorita Startupissa määrättyjä toimintoja 
käynnistyksen yhteydessä. 

Jos siis haluat tehdä samanlaisen käyttöliittymän omaan 
sovellukseesi kuin tässä on esitetty, niin kopioi Valikko-
lomake sovellukseesi ja muuta Startup- eli Käynnistys-
asetuksia kuten edellä. 

• Sinun kannattaa tutustua myös Accessin uuteen 
toimintoon, joka loihtii sinulle käyttöliittymän 
sovellukseen. Anna Tools-valikosta komento Add-ins > 
Switchboard Manager (Työkalut → Apuohjelmat), 
muokkaa (Edit-painike) Main Switchboard (default) 
-nimistä päävalikkoa lisäämällä (New-painike) siihen 
toimintoja. 

  

 
Lopullinen päävalikko näyttää suurin piirtein seuraavalta: 

 



146 ACCESS 2003 -OPAS 

6. Lomakkeet ja raportit 

 
 J

ou
n

i 
H

u
ot

ar
i,
 A

ri
 H

ov
i 
&

 P
ek

k
a 

M
ak

k
on

en
 1

9
9
2
-2

0
0
5
 

6.8 Vinkkejä ja huomioita lomakkeen teosta 

� Kun aloitat uuden lomakkeen tekemisen, kannattaa 
ensin tutkia olemassa olevat valmiit lomakkeet. Niistä 
saa joskus kaikkein vähimmällä vaivalla uuden 
lomakkeen. Sama pätee myös tehtäessä uusia 
raportteja, makroja ja moduuleita sekä joskus myös 
kyselyjen ja taulujenkin kohdalla. 

Jos lähdet muuttamaan jotain olemassa olevaa lomaketta 
(tai raporttia), siirry ko. lomakkeen (tai raportin) 
suunnittelunäyttöön, ja tee sen jälkeen valintasi: 

• jos haluat muuttaa yksittäistä kontrollikenttää, 
kaksoisnapsauta sitä ja siirry Control Source -kohtaan 

• jos haluat muuttaa taulua tai kyselyä, joka toimii 
lomakkeen (raportin) lähteenä, muuta lomakkeen 
(raportin) ominaisuuksia seuraavilla komennoilla: 

1. Edit → Select Form (tai Report) (eli Muokkaa → 
Valitse lomake tai raportti)  

2. View →→→→ Properties (Näytä → Ominaisuudet) 

3. muuta Record Source -kohtaan jokin toinen taulu tai 
kysely 

���� Jos haluat lomakkeeseen tai raporttiin tietoja 
useammasta taulusta, pitää sinun tehdä sitä varten 
monen taulun liitoskysely, joka on sen jälkeen 
lomakkeen tai raportin tietojen lähteenä (kuten Lasku-
lomakkeelle tehtiin). 

Kun liikut esim. tabulointi- eli sarkainnäppäimellä 
kentästä toiseen, määräytyy seuraava kenttä sen 
järjestyksen mukaan, jolla valitsit kentät lomaketta (tai 
alunperin taulua) tehdessäsi. Jos haluat muuttaa 
sarkainjärjestystä, anna View-valikosta komento Tab 
Order (Näytä → Sarkainjärjestys). Auto Order (Auto-
maattinen järjestys) -painikkeella saat järjestyksen 
automaattisesti oikein (siirtyminen vasemmalta oikealle ja 
ylhäältä alas). 
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Lohkon (esim. Detail Section) koko muutetaan vetämällä 
hiirellä lohkon ylälaidan reunaviivasta  -osoittimella. 
Voit myös muuttaa lomakkeen vasemman ja oikean 
marginaalin sijaintikohtaa vetämällä vasemmassa ja/tai 
oikeassa reunassa olevasta viivasta  -osoittimella.  

���� Lomakkeella on kahden tyyppisiä yläotsakkeita: 
lomakeotsakkeita (form header) ja sivuotsakkeita 
(page header). Lomakeotsakkeet näkyvät sekä näytöllä 
että tulostettaessa, mutta sivuotsakkeet näkyvät vain 
tulostettaessa.  

� Lomakkeen leveys ei saisi olla yli 15 cm, jos haluat 
sen näkyvän kokonaan VGA-näytöllä (640x480 
resoluutio). 800x600-resoluutiolla lomakkeen leveys 
voi olla jo lähes 20 cm. Testaa aina sovellustasi eri 
koneissa, ettei tärkeitä tietoja “häviä” näytön 
ulkopuolelle. 
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7 Raportit ja tarrat 
Tässä luvussa esitellään erilaisten raporttien tekemiseen 
liittyvät perusperiaatteet. Koska raportti tehdään ja 
muokataan samaan tapaan kuin lomake, löytyy esim. ohje 
raportin muokkaukseen edellisistä luvuista. 

Raportti on ulkoasultaan ja tietojen ryhmittelyltään suun-
niteltu nimenomaan tulostusta varten. Raportti tehdään 
samaan tapaan kuin lomake, mutta raportin suunnitte-
lussa on enemmän mahdollisuuksia vaikuttaa tulos-
tettavan tiedon ulkoasuun ja sisältöön. Raportissa 
voidaan tiedot ryhmitellä myös taulun sisällä, jolloin 
saadaan aikaan esim. välisummia (samaan tapaan kuin 
tehtiin Asiakastiedot-lomakkeessa Henkilö-alilomakkeelle). 

7.1 Raporttityypit 

Uuden raportin tekemisessä voit valita kuudesta eri 
vaihtoehdosta (ks. kuva s. 150). Useimmiten perusraportti 
luodaan yksisarakkeisena (columnar) tai moni-
sarakkeisena tabuloituna (tabular) raporttina, joka sitten 
muokataan itselle sopivaksi. Voit myös aloittaa aivan 
tyhjästä raportista (design view) tai käyttää velhoa (report 
wizard). Muita vaihtoehtoja ovat osoitetarrat (mailing 
labels) ja kaaviokuvan (chart) sisältävä raportti. 

 
Yksisarakkeinen 

 
Monisarakkeinen 

 
Osoitetarrat 

Osoitetarrat ovat yksisarakkeisen tyypin erikoistapaus, 
jossa on mahdollista hyvinkin tarkasti määrätä eri 
kenttien sijainnit tarroilla (s. 158).  

7.2 Uuden raportin tekeminen 

� Avaa LASKU1.MDB-tietokanta. 
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Voit tehdä uuden raportin automaattisella pikatoiminnolla 
samoin kuin lomakkeenkin. Valitse ensin taulu tai kysely, 
joka sisältää raporttiin tarvittavat kentät. 
Napsauta sen jälkeen pikaraporttityökalu-
painiketta ja Access muodostaa yksi-
sarakkeisen raportin.  

� Valitse ASIAKAS-taulu.  

� Anna AutoReport (Automaattinen raportin luominen) 
-komento. 

 
Raportti tulee näkyviin nk. esikatselutilassa. Voit 
suurennuslasilla tarkastella tietoja lähempää ja alalaidan 
siirtymäpainikkeilla voit selata sivuja eteenpäin. 

Seuraava sivu  

1. sivu   Viimeinen sivu 

Edellinen sivu Siirry suoraan sivulle 
  (kirjoita sivun numero ja paina Enter) 

 

� Sulje raportti komennolla File → Close (Tiedosto → 
Sulje). 

� Tallenna raportti nimellä Asiakastiedot. 

7.3 Raportin tekeminen ohjatusti 

Toinen nopea vaihtoehto tehdä raportti on tehdä se 
ohjatusti raporttivelhoa käyttäen. Velholla voit voit 
vaikuttaa esimerkiksi raportissa esiintyvien kenttien 
valintaan. Tämä käydään läpi seuraavaksi. 
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Tehdään esimerkkinä laskupäiväkirja, johon kerätään 
asiakkaittain tiedot vuoden laskutuksesta. Raportti 
perustuu olemassa olevaan kyselyyn Henkilö-Asiakas-
Lasku. 

1. Napsauta Reports (Raportit) -kielekettä tietokanta-
ikkunassa. 

2. Napsauta New (Uusi) -painiketta. 

3. Napsauta listassa kerran riviä Report Wizard (Ohjattu 
raportin luominen). Valitse sen jälkeen taulu / 
kysely-listasta Henkilö-Asiakas-Lasku-kysely. 

 

4. Kun painat OK:ta, raporttivelho kysyy mitä kenttiä 
haluat raporttiisi. Ota mukaan seuraavat kentät 
(kaksoisnapsauttamalla kenttänimen päällä): 
Asiakastunnus, Asiakkaan nimi, Laskun nro, Laskun pvm, 
Lasku yhteensä, Maksun pvm. 
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5. Kun painat Next (Seuraava) -painiketta, raporttivelho 
kysyy ryhmityksestä. Ryhmitä (group) tiedot 
Asiakastunnus-kentän mukaan (paina -painiketta). 

���� Grouping Options (ryhmitysasetukset) -painikkeen 
kautta voit määrätä, kuinka monta merkkiä 
Asiakastunnus-kentästä riittää ryhmittelemään tiedot. 
Normal (Normaali) -ryhmitys on oletusarvona, jolloin 
jokainen Asiakastunnus huomioidaan. 

6. Seuraavaksi (paina Next) sinun pitää päättää, 
haluatko lajitella asiakkaan laskuja jollakin 
kriteerillä. Lajittele tietueet laskun numeron 
mukaiseen järjestykseen. 

 

���� Summary Options (yhteenvetoasetukset) -painikkeen 
kautta voit määrätä, mitä asioita haluat varsinaisten 
tietojen alapuolelle laskettavan. Älä laita rastia 
Calculate Percent of total for sums (laske prosentti-
osuudet yhteissummasta) -kohtaan, koska prosentti-
määrien esittäminen lienee laskupäiväkirjassa turhaa. 
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7. Seuraavaksi sinun pitää valita raportin ulkoasu. 

Valitse esimerkiksi Outline 2 -tyyli ja sivun asetteluksi 
Portrait eli pystyarkki. 

 

8. Tämän jälkeen pitää valita vielä tarkempi 
ulkoasutyyli. Kokeile eri vaihtoehtoja, mutta tehtyäsi 
valinnan käytä sitä muissa myöhemmin tehtävissä 
raporteissa. Tällä tavoin raporttisi näyttävät 
yhdenmukaisilta. 
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9. Viimeisessä vaiheessa pitää antaa raportille nimi. 
Muuta nimeksi Laskupäiväkirja.  

10. Paina Finish (Valmis) -painiketta. 

Jos valitsit esikatselun (preview), voit tarkastella raporttia 
eri näkökulmista napsauttamalla suurennuslasityökalua 

, selata eri sivuja käyttämällä pieniä sivupainikkeita 
näytön alalaidassa tai tulostaa sen esim. File-valikon 
Print (Tiedosto → Tulosta) -komennolla. 

� Tallenna raportti File-valikon Save-komennolla 
(Tiedosto → Tallenna). Anna nimeksi Laskupäiväkirja. 
Sen jälkeen voit sulkea raportin. 

Raportin muokkaus 

Raporttia muokataan valitsemalla raportti ja painamalla 
Design-painiketta. Accessin raporttimäärittelyt jakautuvat 
lohkoihin (sections). Raportilla on esimerkiksi ylätunniste 
(Report Header), johon tulevat 1. sivun aivan yläosaan 
sijoittuvat tekstit, kuten raportin nimi. Raportin 
ylätunniste tulee vain yhden kerran koko raporttiin. 

Raportti päättyy alatunnisteeseen (Report Footer). Niiden 
välissä on sivun ylätunniste (Page Header) ja sivun 
alatunniste (Page Footer), joihin tulevat näkyviin joka 
sivulle tarvittavat tekstit, esimerkiksi sivun numero. 
Edelleen keskemmälle mentäessä tulevat ryhmien 
(Category) ylä- ja alaotsakkeet ja kaikkein keskimmäisenä 
Detail (Tiedot) -osa, johon varsinaiset tietueet tulostuvat, 
ks. kuva  
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Kuva 13. Ryhmitelty summaraportti sisältää erilaisia lohko-
määrittelyjä (mm. Detail eli Tiedot lohko) 

Jos haluat asemoida kohteet raportissa, voit toimia 
samalla tavoin kuin lomakkeen kohdalla (luku Kohteiden 
tasaus, s. 117). Jos haluat käyttää apuruudukkoa 
apunasi, sinun pitää ensin valita raportti Edit-valikon 
Select Report -komennolla (Muokkaa → Valitse raportti) 
ja vasta sitten muuttaa raportin ominaisuusmäärittelyihin 
Grid X ja Grid Y -kohtiin luvuksi esim. 10. Muistathan 
asettaa apuruudukon päälle Format-valikon Snap to 
Grid -komennolla (Muotoile → Kohdista ruudukkoon). 

� Tee seuraavat muutokset Laskupäiväkirja-raporttiin: 

1. Asiakastunnus Header (Ylätunniste) -lohko: 
siirrä Asiakkaan nimi -kenttä 
Asiakastunnuksen viereen viemällä hiiren 
osoitin kentän päälle ja vetämällä se suoraan 
sinne (älä siis napsauta kenttää vaan pidä 
hiiren vasenta nappia pohjassa koko ajan) 

• lihavoi se (napsauta  -painiketta). 

• Siirrä muut Asiakastunnus Header -lohkon kentät 
Detail (Tiedot) -lohkoon (lassoa ne hiirellä). 

• Jos Detail (Tiedot) -lohkon kentät on lihavoitu, poista 
lihavointi -painikkeella. 
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• Pienennä raportin otsikkoa (napsautus, jonka jälkeen 
vedät hiirellä tekstilaatikon oikeassa laidassa olevasta 
mustasta pisteestä). 

• Siirrä =Now() ylätunnistelohkoon (Report Header) 
keskelle. 

• Muuta halutessasi =Now() -kontrollikentän 
esitysmuotoa (Format) kaksoisnapsauttamalla sitä. 

• Siirrä =Page (=Sivu) oikealle sivun yläosaan (Page 
Header eli Sivun ylätunniste -lohkoon). 

 

• Automaattinen sivunumerointi pitää olla joko Page 
Header tai Page Footer (Sivun ylätunniste tai 
alatunniste) -lohkossa, jotta sivunumero tulisi jokai-
selle sivulle mukaan. 

• Muuta em. kenttien kirjasintyyppi vastaamaan 
raportin Laskupäiväkirja-otsikossa olevaa teksti-
tyyppiä (esim. Times New Roman 14 pt). 

• Jos tekstit eivät mahdu enää raameihinsa, kaksois-
napsauta kentän alakulmassa olevaa pientä mustaa 
pistettä (se vastaa Format-valikon Size to Fit 
-komentoa eli Muotoile → Muuta kokoa). 

• Kentät asemoidaan samaan linjaan valitsemalla ne 
(napsautus viivaimella vasemmassa laidassa) ja 
antamalla Format-valikosta komento Align > Bottom 
(Muotoile → Tasaa > Alareuna). 

• Tee tilaa uudelle kentälle asiakkaan laskutietojen lop-
puun (Asiakastunnus Footer -lohkoon) vetämällä hii-
rellä Page Footer (Sivun alatunniste) -lohkoa alaspäin. 

• Lisää Asiakastunnus Footer (alatunniste) -lohkoon 
Laskut yhteensä -niminen kontrollikenttä (Control 
Name) käyttämällä -työkalua (työkalut saat esille 



156 ACCESS 2003 -OPAS 

7. Raportit ja tarrat 

 
 J

ou
n

i 
H

u
ot

ar
i,
 A

ri
 H

ov
i 
&

 P
ek

k
a 

M
ak

k
on

en
 1

9
9
2
-2

0
0
5
 

komennolla View → Toolbox eli Näytä → 
Työkaluryhmä). 

• Tavallista tekstiä lisätään napsauttamalla -
työkalua, valitsemalla paikka tekstille (napsautus 
työalueella) ja kirjoittamalla sitten teksti.  

• Kirjoita Laskut yhteensä -kentän Control Source 
-kohtaan kaava =Sum([Lasku yhteensä]) 

• Muuta Format (Muoto) -kohtaan Currency (Valuutta), 
niin luku tulee valuuttamuodossa. 

• Suurenna Laskut yhteensä -kentän kirjasinta kokoon 
12. 

• Piirrä vaakasuora viiva Laskut yhteensä -kentän 
yläpuolelle -työkalulla. 

� Paina Shift-näppäin pohjaan niin saat varmasti 
vaakasuoran viivan. 

� Lisätehtävänä voit tuoda esim. Laskun tila ja/tai 
Arvonlisäverollinen-kentät Laskupäiväkirjan Detail 
(Tiedot) -lohkoon, jos ne sinne kunnolla mahtuvat. 
Kentät tuodaan kätevimmin vetämällä kenttälistasta, 
jonka saat näkyviin -työkalupainikkeella. Tee sen 
jälkeen seuraavat korjaukset: 

• Muuta Arvonlisäverollinen-kentän muotoiluksi 
(format): ;"Sis. ALV";"Alv 0%" 

• Tee Eräpäivä-kontrollikenttä ja kirjoita siihen 
seuraava laskukaava:  =[Laskun pvm]+[Maksuaika] 

• Muuta Laskun tila -kenttä vaihtoehtoryhmäksi 
(periaate selostettu lomakkeen teon yhteydessä) 

• Turhat kentät ja viivat poistetaan napsauttamalla 
niitä ja painamalla Delete-näppäintä.  

Lohkojen lajittelu ja ryhmittely tehdään joko  
-painikkeen kautta tai antamalla View-valikosta komento 
Sorting and Grouping (Näytä → Lajittelu ja ryhmittely). 
Näkyviin tulee ikkuna, jonka kautta on mahdollista mm. 
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muuttaa, poistaa ja lisätä lajittelukenttiä, muuttaa 
ryhmittelyperustetta (Group On) ja lajittelujärjestystä (Sort 
Order; Ascending tarkoittaa aakkosjärjestystä tai 
numeroiden osalta pienintä ensin). 

 
Keep Together (Yhdessäpitäminen) -kohtaan voidaan valita 
Whole group (Koko ryhmä), jolloin Access pitää yhdessä 
kaikkia ryhmään kuuluvia rivejä, eikä jaa niitä eri sivuille. 

Huomioita raporttien tekemisestä 

Lasku-raportissa (sijaitsee LASKUTUS.MDB:ssä) kannattaa 
huomioida mm. seuraavat kohdat: 

• Raportti perustuu kyselyyn Henkilö-Asiakas-Lasku 

• Henkilön nimi saadaan kaavalla  
=[Etunimi] & " " & [Sukunimi] 

• Laskurivit-aliraportti muotoillaan tarvittaessa erikseen 

• ALV% haetaan Yleisasetukset-taulusta DLookUp-
funktiolla (ks. seuraava kuva) 

 

• Huomaa myös muoto (format): Percent (Prosentti) 
kertoo automaattisesti luvun sadalla ja laittaa %-
merkin luvun perään 

Raportteja muokatessa (esimerkiksi siirrettäessä kenttiä 
oikeasta laidasta vasemmalle) saattaa raportin oikeaan 
laitaan jäädä tyhjää tilaa ja se saattaa aiheuttaa tyhjien 
sivujen tulostumisen! Poista tyhjä tila vetämällä hiirellä 
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“paperin” oikeasta reunaviivasta vasemmalle. Toinen 
vaihtoehto saada asiat mahtumaan yhdelle paperille on 
muuta sivu vaaka-arkiksi (File → Page Setup eli Tiedosto 
→ Sivun asetukset). 

 

7.4 Tarrojen tekeminen 

Postitustarrojen tekeminen on eräs Accessin fiksuista 
piirteistä. Tehdään ASIAKAS.MDB-esimerkkitietokannan 
asiakastiedoista postitustarrat seuraavasti: 

1. Aloita uusi raportti ja perusta raportti FIRMA-tauluun. 
Valitse listasta Label wizard (Ohjattu tarrojen 
luominen). 

 
2. Painettuasi Enteriä seuraavasta ruudusta pitäisi 

löytää tarra-arkkiasi vastaava vaihtoehto. 

3. Seuraavaksi voit määrätä tarralle tulostuvan fontin. 
Koko voisi olla vähintään 10 pt. 
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4. Sitten näkyviin tulee seuraavankaltainen 
valintaikkuna: 

 
5. Valitse Asiakkaan nimi, Katuosoite ja Postinro  

-painikkeella ja lisää kunkin rivin loppuun aina 
rivinvaihto Enter-näppäimellä. Ennen kuin lisäät 
Postitoimipaikan, paina Välilyönti-näppäintä. Siirry 
sitten eteenpäin Next (Seuraava) -painikkeella.  

6. Seuraavaksi sinun pitää valita lajittelukriteeri. Valitse 
esim. Asiakkaan nimi ja paina Next (Seuraava) -
painiketta. Anna tarraraportille nimi. Kun painat 
lopuksi Finish (Valmis) -painiketta, tulee näkyviin 
tarrat esikatselutilassa. Napsauta Close (Sulje) 
-painiketta, niin pääset suunnittelutilaan.  

���� Jatkossa (suljettuasi raportin): jos avaat raportin 
muokkausta varten, avaa se ensin suunnittelutilaan 
ja testaa sitä sitten esikatselussa. 

Näytöllä on seuraavankaltainen Detail (Tiedot) -osa: 

 

Jos haluat jälkeenpäin muuttaa fontin kokoa tai tyyppiä, 
valitse kaikki kentät lassoamalla ja muuta kirjasintyypiksi 
esim. Arial 10: 
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Muuta sitten kenttien koko vastaamaan kirjasinkokoa: 
Format → Size to Fit (Muotoile → Muuta kokoa). 

Muuta kenttien sijaintia alaspäin. Valitse tarvittaessa taas 
kaikki kentät lassoamalla ja anna komento Format → 
Align > Left (Muotoile → Tasaa > Vasemmalle). Siirrä 
lopuksi kenttiä hieman alaspäin, koska kirjoittimessa on 
luultavasti oma ylämarginaalinsa. Jos ylin tekstikenttä on 
liian ylhäällä, käy tulostuksessa seuraavasti (katso itsekin 
esikatselusta): 

 
Voi olla, että joudut tekemään jonkin verran 
laskutoimituksia saadaksesi selville oikean tarrakoon. 
Esim. A4-kokoinen (29,7 mm x 21 mm) tarra-arkki, joka 
sisältää 8x3 tarraa, saa seuraavat arvot: 

• raportin eli tarran leveys (width) on 6,3 cm; 3 * 6,3 cm 
= 18,9 cm 

• detail-lohkon eli tarran korkeus on 3,6 cm; 8 * 3,6 = 
28,8 cm 

• tulostuksen asetukset (File → Page Setup eli Tiedosto → 
Sivun asetukset): paperin leveys 21 cm, josta vähen-
netään tarrojen yhteenlaskettu leveys 18,9 cm. Jäljelle 
jäävä 2,1 cm jaetaan vielä neljään osaan: Vasen ja 
oikea marginaali ovat n. 0,75 cm (yhteensä 1,5 cm) ja 
sarakevälistys on n. 0,3 cm (leveyssuunnassa tarrojen 
väliin jää aina 3 mm). 
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• paperin korkeus 29,7 cm - tarrojen yhteenlaskettu 

korkeus 28,8 cm = 0,9 cm = 2 * 0,45 cm; nämä arvot 
Margins-kielekkeen Top ja Bottom (Ylä ja Ala) –kohtaan 


